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1. ORDERING GUIDE

Configure a model number in this format: LTE60FR 

Transmitter Type 

LTE..Pulse input transmitter with 4-20 mA, 0-20 

mA or 0-10V isolated analog output, iso-

lated Ethernet serial data output (Modbus 

or Custom ASCII protocol), two isolated 

solid state relays, and isolated transducer 

excitation output. Default jumpered for 10V 

excitation. 

Main Board 

6 ............................... Standard pulse or AC input 

8 ............................... Extended pulse of AC input 

Please see notes for “Extended.” 

Power 

0 ....................................................... 85-264 Vac 

1 .................................... 12-32 Vac or 10-48 Vdc 

Input Type 

FR .................. .. Dual Channel Pulse or AC Input 

Standard main board 

Frequency (2 channels), rate (2 channels), total 

(2 channels), period, stopwatch, time interval. 

Extended main board 

Above plus rate and total simultaneously, linear-

ized inputs using up to 180 points, arithmetic 

functions applied to channels A & B (A+B, A-B, 

A*B, A/B, A/B-1), phase angle, duty cycle, up/ 

down counting, batch control. 

VF1 ............................. .. 4-20 mA Process Input 

VF2 ............................... .. 0-1 mA Process Input 

VF3 ................................. .. 0-10V Process Input 

VF4 ............................................ .. Custom Input 

Standard main board 

Rate or total from analog process signals. 

Selectable square root extraction for use with 

differential pressure flow meters. 

Extended main board 

Above plus rate and total simultaneously (analog 

totalizer), custom curve linearization using up to 

180 points, batch control, and time based on 

rate. 

QD .................................................. .. Quadrature 

Standard main board 

Position or length from encoders. Accepts diffe-

rential or single-ended inputs: 1x, 2x or 4x, plus 

zero index. 

Extended main board 

Above plus bidirectional rate (rate and position 

or length are not simultaneous).  
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3.  COMPLEMENTARY MANUALS 

 
This manual covers LTE Series DIN rail transmitters with an isolated 4-20 mA output, Ethernet I/O, 

dual relays, and pulse inputs to the microcomputer. The signal conditioners be for dual pulse inputs, for 

quadrature, or for an analog signal (4-20 mA, 0-1 mA or 0-10V), which is converted to a pulse input by a 

voltage-to-frequency converter. This manual covers hardware aspects such a pinout and on-board 

jumpers, and transmitter setup such as scaling and relay setpoints. It also presents the main 

commands and text strings to be used with the Modbus and Custom ASCII communications 

protocols. It is intended to be used with the following separate manuals: 

• Ethernet Manual. Covers Ethernet Node discovery and setup using Node Manager PC 

Software or the Web Server Software built into each Node. Required for use of Ethernet 

transmitters and normally shipped with this manual.  

• Modbus Communications Manual. Covers strings and commands to be used with the 

Modbus protocol (if selected). Intended for programmers. 

• Serial Communications Manual. Covers strings and commands to be used with Custom 

ASCII protocol (if selected). Intended for programmers. 

LT Series DIN rail transmitters with an isolated 4-20 mA output, RS232 or RS485 I/O, dual relays, 

and a pulse input signal conditioner are covered in a separate manual.  
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4.  PRODUCT OVERVIEW 

 
LTE Series counter transmitters duplicate the signal conditioning and signal processing features 

of our 1/8 DIN panel-mounted counters for exceptional performance at high read rates. Signal 

sources are accommodated by three signal conditioner boards, which are the same as for our 

panel-mounted counters: 

• Dual-channel pulse input signal conditioner (for frequency, rate, total, arithmetic combina-

tions of two channels, stopwatch, timer, phase angle, duty cycle).  

• Voltage-to-frequency signal conditioner (for rate or total from 4-20 mA, 0-1 mA or 0-10V 

process signals). 

• Quadrature signal conditioner (for position or rate from quadrature encoder signals). 

Extended software capabilities are provided by an “Extended” main board, which needs to be 

specified at the time of order. Please see our Ordering Guide on page 2 and the signal conditioner 

sections of this manual. 

An isolated 4-20 mA, 0-20 mA or 0-10V output is standard. This output is generated by an ultra-

linear 16-bit digital to analog converter which tracks an internal linearized digital reading. 

Isolated Ethernet communications are standard via an RJ45 connector for a 10/100BaseT 

interface. Four serial communication protocols are understood by our transmitters:  Modbus TCP, 

Modbus RTU, Modbus ASCII, and Custom ASCII (a simpler protocol than Modbus). 

An isolated transducer excitation output is standard. Three output levels are jumper selectable: 

5V at 100 mA, 10V at 120 mA, or 24V at 50 mA. The factory default setting is 10V. 

Two control inputs are standard. These can be programmed for function reset or meter reset, or 

to change operation of the Extended transmitter. A control input is applied by connecting that 

input to digital ground using an external switch. 

Two isolated solid state relays are standard. These are rated 120 mA at 140 Vac or 180 Vdc. 

Isolation to 250V rms is provided for power, signal input, analog output, relay outputs, and com-

munications. Isolation adds safety and avoids possible ground loops. The transducer excitation 

output is isolated to ±50V from signal ground. 

Internal jumpers are used to select the signal range and excitation level. The transmitter 

configuration is specified by the model number on the transmitter label. A user can reconfigure 

the transmitter by opening the case and moving jumpers. 

Transmitter scaling is via serial connection to a PC using MS Windows based Instrument Setup 

Software, which can be downloaded at no charge. 
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5.  RECEIVING & UNPACKING YOUR TRANSMITTER 

 
Your transmitter was carefully tested and inspected prior to shipment. Should the transmitter be 

damaged in shipment, notify the freight carrier immediately. In the event the transmitter is not 

configured as ordered or is inoperable, return it to the place of purchase for repair or replacement.  

Please include a detailed description of the problem. 

6.  SAFETY CONSIDERATIONS 

 
 

 Warning: Use of this transmitter in a manner other than specified may impair the protection 

of the device and subject the user to a hazard. Do not attempt to operate if the unit shows visible 

damage. 

Cautions:  

• This unit may be powered from 85-264 Vac or with the worldwide voltage power supply 

option, or from 12-32 Vac or 10-48 Vdc with the low voltage power supply option. Verify that 

the proper power option is installed for the power to be used.  

• The 85-264 Vac power connector (P1 Pins 1-3) is colored Green to differentiate it from other 

input and output connectors. The 12-32 Vac or 10-48 Vdc power connector is colored Black. 

This transmitter has no power switch. It will be in operation as soon as power is applied. 

• To avoid dangers of electrocution and/or short circuit, do not attempt to open the case while 

the unit is under power.   

• To prevent an electrical or fire hazard, do not expose the transmitter to excessive moisture. 

Do not operate the transmitter in the presence of flammable gases or fumes, as such an 

environment constitutes an explosion hazard.  

Symbols applicable to this product: 

 
Caution (refer to accompanying documents) 

 
Earth (ground) terminal. 

 

 
Caution, risk of electric shock.  Both direct and alternating current. 

 
Equipment protected throughout by double 

insulation or reinforced insulation. 

4006497  

ETL Mark. Indicates that product 

conforms to UL Std. 61010-1 and is 

certified to CAN/USA Std. C22.2 No. 

61010-1. Mark pending as of Oct 

2013. 
 

CE Mark. Indicates that the product meets  

EU safety, health and environmental requi-

rements. 
  

Operating environment: 

Transmitter Class II (double insulated) equipment designed for use in Pollution degree 2. 
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7.  LTE TRANSMITTER MAIN BOARD JUMPERS & FIELD WIRING 

 

An RJ45 Ethernet connector allows the transmitter to be connected directly to a computer, router, 

switch or hub via an Ethernet cable. An isolated analog output and dual relays are also standard. 

Jumpers on the main board allow selection of the following: 

• Analog output (current or voltage). This output is sourcing. Do not apply an external voltage. 

Applying an external voltage of 24 Vdc will burn out the transmitter main board. 

• Excitation output. Attempting to draw more than the rated transducer excitation output current 

will shut down the output. 

Jumpers on analog input signal conditioner boards are described in later manual sections. 

Normal operation, as opposed to factory test, requires that the E6 jumper be installed as shown. 

To reset the transmitter (same as power-up), press the Reset button. 

To reset communications to 9600 baud, command mode, Custom ASCII protocol, and Address 1, 

place a jumper at E1, turn power on and off, remove the jumper, and restart the transmitter.  

Analog Output Jumpers 

Current (0-20 or 4-20 mA) E2 a + d 

Voltage (0-10V) E2 b + c 

Communication Reset Jumper 

Jumper + power-up E1 
 

Excitation Output Jumpers 

5V, 100 mA E3 a + c; E4 a 

10V, 120 mA E3 a + c; E4 b 

24V, 50 mA E3 b, E4 none 
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8.  PROGRAMMING YOUR TRANSMITTER 

 
OVERVIEW 

LTE transmitters are easily programmed by connecting them to the same LAN as a PC or by 

connecting them directly to a PC with an Ethernet cable, and then running Instrument Setup 

Software on the PC. This MS Windows based software allows Node and Device discovery, 

uploading, editing, downloading and saving of setup data, execution of commands under 

computer control, listing, plotting and graphing of data, and computer prompted calibration.  

INSTALLING INSTRUMENT SETUP SOFTWARE 

Download the file ISx_x_x.exe from our website and double-click on the file name. Click on 

Install Instrument Setup Software and follow the prompts.  

LAUNCHING INSTRUMENT SETUP SOFTWARE 

Connect your LTE transmitter to your PC via an Ethernet cable, or connect the transmitter to the 

same LAN as the PC. To launch IS software, press on Start => Programs => IS2 => Instrument 

Setup or on the desktop icon that you may have created. Following a brief splash screen, the 

Communications Setup screen will appear. 

 

In the Communications Setup screen, select Transmitter LTE as the Device Type, Ethernet as 

the Communication Type, any of the protocols listed.  
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Upon clicking on Ethernet for the first time, you may be presented with the Windows Security 

Alert shown below. Click on Unblock, and IS software will be launched. If you ever click on 

Keep Blocking, IS software will not be able to establish Ethernet communications. You will then 

need to restore Windows Firewall defaults by clicking on Control Panel => Windows Firewall => 

Advanced => Restore Defaults. 

 

The Node Discovery tab under Node Setup will open once you have passed the Windows 

Firewall. With a direct cable connection to the PC, only one Ethernet Node will be listed. With a 

LAN connection, multiple Ethernet Nodes may be discovered on the same LAN. Select the Node 

which is integral with your transmitter Device. 
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Click on the Device Discovery tab, and all Devices attached to your Node will be listed. With an 

LTE transmitter, the transmitter will be the only Device listed. With a device server Node, there 

can be up to 30 Devices (meters and transmitters) on an RS485 bus. Please see our Ethernet 

manual. 

Highlight your Node, and you will be able to assign a descriptive name to it, such as Tank Farm. 

The default name is the Node’s unique MAC address. You can also use this tab to change your 

Node’s communication settings. Press Get to retrieve settings from the Node to the PC. Press 

Put to write settings from the PC to the Node.  

Highlight your Device, and you will be able to assign a descriptive name to it, such as Flow 

Rate. Press Get to retrieve settings from the Device to the PC. Press Put to write settings from 

the PC to the Device. 
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Click on the Advanced Settings tab, and you will be given the opportunity to change the Node’s 

TCP and UDP Port settings. Press Get to retrieve settings from the Node to the PC. Press Put to 

write settings from the PC to the Node. 

If a browser is to access our Nodes on a remote LAN over the Internet, port forwarding must 

first be set up for the router that controls the remote LAN. The default port numbers pro-

grammed into our Nodes are UDP port 63179 for Node discovery and TCP port 502 for Modbus 

TCP. If these ports are blocked by the router or by a firewall, different port values can be entered 

into our Nodes. You or your company’s IT department will then also need to set up the remote 

router to forward these different port values. 

As an aid to diagnostics, the Ethernet connector for all of our Ethernet Nodes is provided by an 

RJ45 jack, where green and amber LEDs on the jack indicate network operation: 

1) Following power-up, the green and amber LEDs are on 

steady until an IP address has been assigned to the Node. 

2) Once an IP address has been assigned to the Node, the 

amber LED is turned off. It will light up whenever the Node 

detects data packet activity. 

3) When the Node has made a TCP connection, the green LED 

alternates on (1 sec) and off (1 sec), while the amber LED 

is on steady.  

Ethernet cables (CAT5 or better) can be straight-through or crossover. Our Ethernet Nodes 

automatically adapt for either. 

Ethernet Indicators 

8
7
6
5
4
3
2
1

Amber LED      

Green LED

RX -

RX +
TX  -
TX +
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To reach the above Input+Display tab screen, follow this procedure: 

1) Highlight your device under the Device Discovery tab. 

2) Click on the Main Menu button. A new Counter Main Menu window will open with a help 

screen. Click on Counter in the top menu bar. Our pulse input transmitters and counters use 

the same software. While a scaled digital reading is not displayed by transmitters, it is used 

internally. 

3) Click on Get Setup to retrieve the setup data currently in the transmitter. 

4) Click on View => Setup to reach the above setup window with five tabs. 

The Input+Display tab is used to set up Signal Input Mode, Signal Input Function, Gate Time, 

Time Out, Display Type, Display Filter, Power-On Total, and the roles of Control Inputs 1 and 2.  

Clicking on the Control Inputs field opens a pull-down menu which allows selection of the roles 

of Control Input 1, Control Input 2, and simultaneous Control Inputs 1 and 2. For example, with 

a Dual Pulse Input signal conditioner and the highlighted selection, grounding Control Input 1 

causes a Function Reset, which resets Peak, Valley and latched alarms; grounding Control Input 

2 places the transmitter on Hold, and causes the Peak reading to be transmitted, and grounding 

both Control Inputs 1 and 2 causes a Meter Reset, causes a power-on reset of the transmitter. A 

control input is applied by connecting that input to digital ground using an external switch. 

The above sample screen is for the dual pulse input signal conditioner. The actual screen and 

Control Input choices will be for the detected signal conditioner, and later screens will vary 

depending on selections made in this screen.  

Press the F1 key for context-sensitive help with any item. 
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Click on the Scaling tab to scale your transmitter. The actual screen will vary depending on the 

detected signal conditioner board, signal input and signal function, as selected under the 

Input+Display tab. Press the F1 key for help with any highlighted item. 

 

Click on the Filter tab to set to set up filtering for your readings. The filter time constant can be 

automatic, be specified in seconds, or be turned off. The adaptive threshold modifies the time 

constant in response to noise. A low adaptive threshold is recommended for normal low noise. 

A high adaptive threshold is recommended for high noise environments. Press the F1 key for 

help with any highlighted item. 
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Click on the Relay Alarms tab to set up your transmitter’s two solid state relays, which are 

standard. Press the F1 key for help with any highlighted item. 

 

Click on the Analog Out tab to scale your analog output, which is standard. Under Range, select 

0-20 mA Current, 0-10V Voltage, or 4-20 mA. Type in your Lo Range Reading and Hi Range 

reading. These will create the two endpoints of your analog output range. Press the F1 key for 

help with any highlighted item. 
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PULL-DOWN MENU FEATURES 

• The File pull-down menu allows you to save setup files to disk by pressing on Save Setup and 

to open setup files from disk by pressing on Open Setup. Opened setup files can then be edited 

on the PC, be saved to disk, and be downloaded into Devices by using DPM => Put Setup. 

• The Commands pull-down menu allows you to execute certain functions by using your 

computer mouse. This menu will be grayed out unless a Get Setup has been executed. 

• The Readings pull-down menu provides three formats to display input data on your PC 

monitor. Use the Pause and Continue buttons to control the timing of data collection, then 

press Print for a hardcopy on your PC printer. 

- List presents the latest internal readings in a 20-row by 10-column table. Press Pause at any 

time to freeze the display. Press Print for a hardcopy.  

- Plot generates a plot of internal readings vs. time in seconds. It effectively turns the 

transmitter-PC combination into a printing digital oscilloscope. 

- Graph generates a histogram, where the horizontal axis is the internal reading, and the 

vertical axis is the number of occurrences of readings. The display continually resizes itself 

as the number of readings increases. 

 

Plot 
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Graph 

•   The Jumpers pull-down menu shows jumper positions for the selected signal conditioner 

boards and the main board, duplicating information in this manual. 
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9.  OPENING YOUR TRANSMITTER CASE 

 
WHEN TO CHANGE JUMPERS 

Your transmitter case does not need to be opened if jumpers have already been set by your 

distributor. Otherwise you will need to open the case and either set jumpers or verify that the 

factory default jumpers positions will meet your needs. Jumpers are used for the following: 

1) On the dual channel pulse input signal conditioner board to set trigger levels, frequency 

response, bias resistance, and contact debounce. See Section 9. 

2) On the V-to-F signal conditioner board to set the analog input signal type (0-10V, 0-1 mA 

or 4-20 mA). See Section 10. 

3) On the quadrature signal conditioner board to set the quadrature input type, input termi-

nation, phase for up-counting, count-by options, and zero index polarity. See Section 11. 

4) On the main board to set the serial communication signal (RS232 or RS485), termination 

resistor for long cable runs, analog output signal (current or voltage), and sensor excita-

tion output (5V, 10V or 24V). Default factory settings are RS232, no termination resistor, 

and 10V excitation output. Section 12. 

HOW TO OPEN & CLOSE THE CASE 

  
 

The two clamshell halves of the case are held together with a bolt and a nut at each of the four 

corners. Use a Phillips screwdriver to remove the four bolts. The nut will then drop off, and the 

clamshell halves will separate. When closing the case, make sure that the ventilation grills are 

properly aligned.  

 

Caution: The nuts at the four corners are not captive and are black. Take 

precautions so that the nuts do not fall off and get lost.  
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10.  DUAL CHANNEL PULSE SIGNAL CONDITIONER BOARD 

 

The dual channel signal conditioner board is used for the frequency, rate, period, timing, batch 

control, phase and duty cycle functions. The board needs to be configured via jumpers for the 

input signal type and level. It is recognized by the transmitter software, which will bring up the 

applicable menu items. It does not require calibration, since the quartz crystal oscillator that is 

used for frequency and timing applications is located on the transmitter main board. 

 
 

Jumper Settings for Expected Signal Levels 

The jumper settings for Channel A (A2 & A3) and Channel B 

(B2 & B3) need to be set for the expected signal voltage.  

A voltage input is recognized as a pulse when it exceeds a 

high hysteresis limit, and is unrecognized as a pulse below 

a low hysteresis limit. Hysteresis is used to avoid false 

counts due to electrical noise. A wide hysteresis band 

improves noise immunity. To count negative pulses, 

reverse the inputs to the counter. 

Built-in pull-up or pull-down resistors are used to provide a +5V or -5V signal bias with open 

collector sensors or dry contact closures. They should not be used for other input types. 

Debounce circuitry keeps the meter from counting extra pulses due to contact bounce. High 

voltages Vin can be attenuated by a resistor R in series with the meter’s input resistance, which 

is 100 kΩ for non-biased signals greater than ±3V. This creates a voltage divider, so that the 

sensed voltage is Vin x 100 kΩ / (R + 100 kΩ). 

Function Group Jumper Jumper effect Input Resistance 

Frequency 

Response 

A0 & B0 - 

b 

a 

1 MHz max 

30 kHz max 

250 Hz max 

1 MΩ for V within ±3V 

100 kΩ for V outside ±3V  

Bias Resistor A1 & B1 - 

a 

b 

No pull-up or pull-down 

10 kΩ pull-up to +5V 

10 kΩ pull-down to -5V 
10 kΩ 
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Contact 

Debounce 

A4 & B4 b 

a, c 

c 

No debounce 

3 msec 

50 msec  

No effect on input resistance 

Common Jumper Settings 

Input Type Vmax A0 & B0 A1 & B1 A2 & B2 A3 & B3 A4 & B4 

 Logic levels 250V - - - a b 

 NPN open collector  +25V b a - a b 

 PNP open collector -15V b b - - b 

 Contact closures -15V, +25V a or b a - a a, c 

 Line frequency 250V b - - - a, c 

 Magnetic pickup, 2-wire 250V b - a - b 

 

 

Excitation return

+ Excitation

+B Signal Input

Signal Ground

+A Signal Input

Signal Ground10K

+5V

1

2

3

4

5

6
GND

Signal

Signal conditioner board jumpered for

contact closure  

A contact closure is normally an On/Off switch to 

ground. When the board is jumpered for contact 

closure, the signal seen by the board is +5V when 

the switch is open and 0V when the switch is 

closed. No need to connect excitation, since the 

counter’s internal +5V is applied through a current 

limiting 10K pull-up resistor. 

Excitation return

+ Excitation

+B Signal Input

Signal Ground

+A Signal Input

Signal Ground10K

+5V

1

2

3

4

5

6

Signal conditioner board jumpered for NPN NPN proximity switch

Sensor

electronics

Power

GND

Signal

 

An NPN sensor is like an On/Off switch to 

ground. When the board is jumpered for 

NPN, the signal seen by the board is +5V 

when the switch is open and 0V when the 

switch is closed. Excitation is only used to 

power the sensor electronics. Excitation 

return and signal ground have to be tied 

together. 

Excitation return

+ Excitation

+B Signal Input

Signal Ground

+A Signal Input

Signal Ground10K

-5V

1

2

3

4

5

6

PNP proximity switch

Sensor

electronics

Power

GND

Signal

Signal conditioner board jumpered for PNP
 

A PNP sensor is like an On/Off switch to 

+Excitation. When the board is jumpered 

for PNP, the signal seen by the board is  

-5V when the switch is open and +Excita-

tion when the switch is closed. Excitation 

return and signal ground have to be tied 

together. 
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10.1  RATE & FREQUENCY MODES 

Frequency in Hz is determined by timing an integral number of pulses over a user-specified 

Gate Time from 0 to 199.99 sec and taking the inverse of average period. The typical internal 

display update rate is Gate Time + 1 period + 30 ms. Selecting a longer Gate Time produces a 

more stable reading as more cycles are averaged, but slows down the update rate. At very low 

frequencies, the update rate is controlled by the period. A Time Out from 0 to 199.99 sec is also 

selectable. This is the time the transmitter waits for a signal to start or end a conversion. If the 

signal is not received before the Time Out ends, the transmitter reads zero. The longer the Time 

Out, the lower the minimum frequency that can be processed.  

Rate in engineering units can be obtained by applying a scale factor to frequency, or by using 

the Coordinates of 2 Points method, where two inputs in Hz and the corresponding desired two 

internal readings are entered directly.  

• Rate A, B determines rate independently for Channel A (Item #1) and Channel B (Item #2). 

Either item can be selected for the analog output. 

• Rate A Only determines rate only for Channel A. Channel B is not used. 

• Rate A, A Total (Extended main board) determines Rate for Channel A (Item #1) and Total 

for Channel A (Item #2) since last reset. Total can count down from an offset by entering a 

negative scale factor. 

• Rates A+B, A-B, AxB, A-B, A/B, A/B-1 (Extended main board) can output arithmetic combi-

nations of Rates A and B (Item #1), Rate A (Item #2), or Rate B (Item #3). With rates A and 

B scaled to produce a ratio close to 1 and an offset of -1, the special combination A/B-1, 

called “Draw,” can output percentage changes, such as elongation of material as it passes 

between rollers.  

Applicable to all rate & frequency application examples: 

Connect your transmitter to a PC running Instrument Setup (IS) Software. Establish commu-

nications. To open a setup file for editing, click on “Get Setup” under the Counter tab to retrieve 

the latest setup file from your transmitter, or click on “Open Setup” under the File tab to retrieve 

a previously saved setup file from disk.  

Relay Alarms and Analog Out respond to the counts that are transmitted digitally. While a 

decimal point can be specified and will be transmitted digitally, it does not affect counts (except 

for power factor). For example, the same 58134 count frequency can be transmitted as 58134 

Hz or 58.134 kHz  

Following editing, click on the Main Menu button. Under the Counter tab, click on “Put Setup” 

to download your setup file into your transmitter. Under the File tab, click on “Save Setup As” 

to save your setup to disk if desired. 
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Example 1: Transmit frequency in Hz with 1 Hz resolution 

Application: Transmit digital frequency readings f from 1 Hz to 999999 Hz with no decimal 

point, update rate of 4/sec, and adaptive moving average filter for 0.4 sec. Set analog output to 

0V at 0 Hz and 10V at 25 kHz. 

 

 

 

Solution:  

• Under Input+Display tab and Signal Input, set Mode to “A Rate”, Function to “A only”, Gate 

Time to 0.25 sec, and Time Out to 2 sec. Under Display, set Type to “Norml 999999”.  

• Under Scaling tab, set decimal point to 111111. If “Scale, Offset” is selected as scaling 

method, set Scale to +1.00000, Multiplier to 1, and Offset to +000000. If Coordinates is 

selected as scaling method, enter 0 for Lo In and 0 for High Read. Also enter +100000 for 

High In and +100000 for High Read. To minimize rounding errors, do not enter small values 

for High In and High Read. 

• Under Filter tab, set Time Constant to 0.4 sec.  

• Under Analog Out tab, set Range to “0-10V Voltage”, Lo Range Reading to +000000, and Hi 

Range Reading to +025000. 
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Example 2: Transmit rate as 0-100.00 for a 10 kHz to 11 kHz input 

Application: Transmit 0.00 to 100.00 (with two decimal places) for a 10 kHz to 11 kHz 

frequency input. Set analog output to 4-20 mA for this range. 

 

 

 

Solution:  

• Under Input+Display tab and Signal Input, set Mode to Rate, Function to “A only”, Gate 

Time to 0.1 sec, Time Out to 2 sec, and Display Type to “Norml 999999”.  Native units will 

be Hz. 

• Under Scaling tab, set Decimal Point to two places. If “Scale, Offset” is selected as scaling 

method, set Scale to +1.00000 and Multiplier to 10. Product of Scale and Multiplier will 

ensure that 1000 Hz are displayed as 10,000 counts (decimal point has no effect on 

counts). Also enter an Offset of -100,000 counts (previously selected decimal point will be 

displayed, but has no effect on counts). If Coordinates is selected as scaling method (by far 

the easiest scaling method for this example), simply enter endpoints as shown.  

• Under the Analog Out tab, set Range to “4-20mA Current”, Lo Range Reading to +0000.00, 

and Hi Range Reading to +0100.00. 
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Example 3: Transmit rate in GPM from 36.67 pulse/gallon turbine flow meter 

Application: Transmit rate in gallons per minute with three decimal places from a turbine flow 

meter with a K factor of 36.67 pulses per gallon. Set analog output to 4 mA at 0 GPM and 20 

mA at 30 GPM.  

 

 

 

Solution:  

• Under Input+Display tab and Signal Input, set Mode to Rate, Function to “A only”, Gate 

Time to 0.3 sec, and Time Out to 2 sec. Under Display, set Type to “Norml 999999”. Native 

units will be pulses/sec (Hz). 

• Under Scaling tab, set Decimal Point tab to 111.111. If “Scale, Offset” is selected as scaling 

method, set Scale to 1.63621 with a multiplier of 1000. The scale of 1.63621 is the inverse 

of K factor, namely 0.027270 gallons per pulse, multiplied by 60 to go from the trans-

mitter’s native rate per second to rate per minute. The multiplier of 1000 changes the units 

of volume from gallons to milligallons, as required for three decimal places.  If Coordinates 

is selected as scaling method, enter 0 for Low In and Low Read. Enter 36670 (milli-

gallons/sec) for High In and +060.000 for High Read (60.000 GPM). Note that Low In and 

High In are in converted units after the Multiplier of 1000 to go from gallons to milligallons. 

• Under Analog Out tab, set Range to “4-20mA Current”, Lo Range Reading to +000.000, and 

Hi Range Reading to +030.000, both in GPM. 
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Example 4: Transmit rate of fuel consumptions in liters/km and drive a 0-10V meter 

Application: Transmit a ship’s rate of fuel consumption to two decimal places in liters/km and 

display fuel consumption from 0-100 liters/km on a 0-10V analog meter. Fuel flow is measured 

using a turbine flow meter with a K factor of 5.126 pulses/liter. Speed is measured using a 100 

pulses/km speedometer.  

 

 

Solution:  

• Under Input+Display tab, check Extended (an Extended main board is required). Set Mode 

to Rate and Function to A/B. Set a relatively long Gate Time of 3 sec since the maximum 

speedometer pulse rate is expected to be 2000 pulses/hour at 20 km/hour, or 1 pulse every 

1.8 sec. Set Time Out to its maximum of 199.99 sec, since pulse rates will be very low when 

the ship starts. Click on Read to display Item 1 (A/B). The red field will change to green. 

• Under Scaling tab, set up Item 2 (A Rate or fuel consumption/sec) to have a scale factor of 

0.19508 liters/sec. This is pulses/sec x (1 liter)/(5.126 pulses). Set up Item 3 (B Rate or rate 

of travel in km/sec) to have a scale factor 0.01 km/sec. This is pulses/sec x (1 km)/(100 

pulses). Ignore Decimal Point, since B Rate is not displayed. Set Item 1 (A Rate / B Rate) to 

Decimal Point 2222.22 and Resolution to 100.  This changes the displayed units to centi-

liters/sec. The decimal point is not part of the arithmetic. 

• Under Analog Out tab, set Source to Item 1, Range to “0-10V Voltage”, Lo Range Reading 

to +0000.00, and Hi Range Reading to +0100.00 (liters/km). 
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10.2  PERIOD MODES: Inverse of frequency. Native units are microseconds, so scale appropriately. 

10.3  TOTAL MODES 

• Total A, B determines Total independently for Channel A (Item #1) and Channel B (Item #2). 

Either item can be selected for the analog output. 

• Total A Only determines Total only for Channel A (Item #1). Channel B is not used. 

• Total Burst (Extended main board) determines the total number of signal bursts applied to 

Channel B (Item #1). Gate time should be set to zero. Time Out must be greater than the 

maximum time between bursts. 

• Total B, A Rate (Extended main board) determines Total for Channel B (Item #1) and Rate 

for Channel A (Item #2). 

• Total A, B UpDnCtl (Extended main board) determines Total A (Item #1), where the up or 

down count direction is determined by an input on Channel B. If the menu item SLOPE is set 

to 0 for Channel B, an input level on B below the jumper set Low Threshold B causes the 

count to go up, and an input level above the jumper set High Threshold causes the count to 

go down. If SLOPE for Channel B is set to 1, the opposite occurs. The maximum frequency 

on A that can be counted is 250 kHz, or a minimum of 4 µs between pulses. 

• Total A, B InhibitCtl (Extended main board) determines Total A (Item #1), where counting 

may be inhibited by a control input on Channel B. If the menu item SLOPE is set to 0 for 

Channel B, a low input level on B allows counting, and a high input level inhibits counting. If 

the SLOPE for Channel B is set to 1, the opposite occurs. The maximum frequency on A that 

can be counted is 1 MHz. 

• Totals A+B, A-B, AxB, A/B, A/B-1 (Extended main board) determine arithmetic combinations 

of Totals A and B (Item #1). Total A (Item #2) and Total B (Item #3) are also tracked and 

can be selected for analog output.  

Applicable to all totalizing application examples: 

Connect your transmitter to a PC running Instrument Setup (IS) Software. Establish commu-

nications. To open a setup file for editing, click on “Get Setup” under the Counter tab to retrieve 

the latest setup file from your transmitter, or click on “Open Setup” under the File tab to retrieve 

a previously saved setup file from disk.  

Relay Alarms and Analog Out respond to the units that are transmitted digitally. While a decimal 

point can be specified and will be transmitted digitally, it does not affect the number of units. If 

“Scale, Offset” is used as the scaling method and liquid volume is to be transmitted in L with 

three decimal places, first change the units to mL, then set the decimal point.  

Following editing, click on the Main Menu button. Under the Counter tab, click on “Put Setup” 

to download your setup file into your transmitter. Under the File tab, click on “Save Setup As” 

to save your setup to disk if desired. 
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Example 1: Transmit volume in gallons from a 36.67 pulse/gallon flow meter 

Application: Digitally transmit volume in gallons with two decimal places from a flow meter 

with a K factor of 36.67 pulses/gallon. Also transmit 4-20 mA corresponding to 0-50 gallons. 

 

 

 

Solution:  

• Under Input+Display tab, set Mode to Total, Function to “A Only”, and Gate Time to 0 sec 

(to maximize display update rate). Set “Power-On Total” to “Restore Total” to retain total in 

event of power loss. 

• Under Scaling tab, set Decimal Point to two places. If “Scale, Offset” is selected as scaling 

method, set Scale to 2.72702 and Multiplier to 1. The product of Scale and Multiplier is 

2.72702 hundredths of a gallon/pulse, which is the inverse of K factor. If Coordinates 

scaling method is selected, enter High In and High Read to indicate that 36.67 pulses 

should read 1.00 gallon. 

• Under Analog Out tab, set Range to “4-20 mA current”. Enter 0.00 gallons for Lo Range 

Reading and 50.00 gallows for Hi Range Reading, as shown. 
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Example 2: Transmit simultaneous rate & total from a 36.67 pulse/gallon flow meter 

Application: Digitally transmit rate in gallons/minute with two decimal places from a flow meter 

with a K factor of 36.67 pulses/gallon, also display volume in gallons with no decimal point.  

 

 

Solution:  

• Under Input+Display tab, check Extended (an Extended main board is required). Set Mode 

to Rate and Function to “A, A Total”. Rate A will be Item 1, Total A will be Item 2. In this 

mode, total is calculated by adding rate/sec every sec, not directly from the count of flow 

meter pulses. Set “Power-On Total” to “Restore Total” to retain total in event of power loss. 

• Under Scaling tab for A Rate, set two decimals. If “Scale, Offset” is selected, set Scale to 

+1.63621 and Multiplier to 100. This is inverse of K factor, multiplied by 100 to change 

counts from gallons to hundredths of a gallon, and further multiplied by 60 to go from the 

native rate per sec to rate per minute. If Coordinates is selected, enter Hi In and High Read 

so that 36.67 pulses/sec reads 60.00 gallons/minute (GPM). With both scaling methods, 

rate counts will be in hundredths of a gallon/minute and disregard the decimal point. 

• Under Scaling tab for A Total, set decimal to far right. If “Scale, Offset” is selected, set Scale 

2 to 1.666666 and Multiplier to 0.0001 to go from hundredths of a gallon/minute to gallons/ 

sec. If Coordinates is selected, enter Hi In and High Read so that a rate of 6000 hundredths 

of a gallon/minute is totalized every second to produce a total of 1 gallon. 
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Example 3: Transmit total volume by adding two flow meter channels 

Application: Digitally transmit total volume in gallons to two decimal places from two pipes 

dispensing liquids into the same tank. Flow meter A is calibrated to 36.67 pulses/gallon, flow 

meter B to 58.12 pulses/gallon. Assign the transmitter’s analog output to total volume. 

 

 

Solution:  

• Under Input+Display tab, check Extended (an Extended main board is required for Total). 

Set Mode to Total and Function to “A+B”. “A Total + B Total” will be Item 1, A Total will be 

Item 2, and B Total will be Item 3. Set Gate Time to 0 sec to maximize the update rate. Set 

“Power-On Total” to “Restore Total” to retain total in event of power loss. 

• Under Scaling tab, set both decimal points to two places. If “Scale, Offset” is selected as 

scaling method, set Scale 1 to +2.72702 for A Total and Scale 2 to +1.72057 for B Total. Set 

both Multipliers to 1 so that the product of Scale and Multiplier produces the inverse of K 

factor expressed in hundredths of a gallon/pulse. If Coordinates is selected as the scaling 

method, enter High In and High Read as shown to indicate that 36.67 pulses should read 

1.00 gallon for Channel A, and that 58.12 pulses should read 1.00 gallon for Channel B. 

• Under Analog Out tab, set Source to Item 1 (A Total + B Total). 
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10.4  TIMING MODES 

• Time Interval A to B determines the time between periodic inputs on Channels A and B. 

Timing starts when a pulse is applied to Channel A (positive edge if slope A is 0, negative 

edge if slope A is 1), and ends when a pulse is applied to Channel B (positive edge if slope B 

is 0, negative edge if slope B is 1). Pulse width may be measured by tying inputs A and B 

together and selecting a positive or negative edge to start (Slope A) and the opposite polarity 

edge to stop (Slope B). If multiple start and stop pulses occur during the Gate Time, the 

displayed value is the average of pulse widths. The value is updated at the end of each Gate 

Time. With a scale factor of 1, one count is one microsecond. 

• Stopwatch A to A times individual events applied to Channel A (Item 1) and the accumulated 

“Grand Total Time” of all events since last reset (Item 2). Timing is based on the same 

positive (or negative) edge of start and stop pulses. Time of individual events is reset to 0 

when a new start pulse occurs. Time of accumulated events is reset via a reset line. 

• Stopwatch A to B measures time between a start pulse on Channel A and a stop pulse on 

Channel B. Timing is the same as for A to A, except that positive or negative edges may be 

selected separately for Channels A and B. This allows the pulse width measurement of single 

pulses by tying Channels A and B together. One slope is selected to start timing, and the 

opposite slope to stop timing. 

Applicable to all timing application examples: 

Connect your transmitter to a PC running Instrument Setup (IS) Software. Establish commu-

nications. To open a setup file for editing, click on “Get Setup” under the Counter tab to retrieve 

the latest setup file from your transmitter, or click on “Open Setup” under the File tab to retrieve 

a previously saved setup file from disk.  

Relay Alarms and Analog Out respond to the units that are transmitted digitally. While a decimal 

point can be specified and will be transmitted digitally, it does not affect the number of units. 

Native counts in timing modes are in microseconds. Note that total modes can also be used for 

timing, for example to count 50 or 60 Hz AC power line pulses. Total modes have the advantage 

that they can retain counts in the event of power loss. 

Following editing, click on the Main Menu button. Under the Counter tab, click on “Put Setup” 

to download your setup file into your transmitter. Under the File tab, click on “Save Setup As” 

to save your setup to disk if desired. 
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Example 1: Transmit machine run time with 0.00 hour resolution 

Application: Track two machine run times in hours. Channel A time will have two decimals, will 

be per job for billing purposes, and will be reset at end of each job. Channel B time will have no 

decimals, will be total accumulated hours for machine maintenance purposes, and will be reset 

following maintenance. Turn on a warning light after 1000 hours of run time. 

 

 

Solution:  

• Apply 60 Hz power cycles to channels A and B and measure time by counting pulses using 

the totalizer mode, which can restore total following loss of power. There will be 216,000 

pulses/hour or 0.0000046296 hours/pulse.  

• Under Input+Display tab, set Mode to Total, Function to “A, B” and Gate Time to 0 sec. Set 

“Power-On Total” to “Restore Total” to retain total in event of power loss.  

• Under Scaling tab for Channel A, set decimal point to 2 places. If “Scale, Offset” is selected, 

set Scale to +0.46296 and Multiplier to 0.001 for time in hundredths of an hour per 60 Hz 

pulse. If Coordinates is selected, enter 216000 pulses for 100 hundredths of an hour. 

• Under Scaling tab for Channel B, set decimal point to 0 places. If “Scale, Offset” is selected, 

set Scale to +0.46296 and Multiplier to 0.00001 for time in hours per 60 Hz pulse. If 

Coordinates is selected, enter 216000 pulses for 1 hour. 
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Example 2: Transmit relay closing time in msec with 0.001 msec resolution 

Application: Transmit closing time of a relay in msec with 0.001 msec resolution using stop-

watch mode. Also transmit relay closing time from 0 to 200 msec as a 4-20 mA signal. 

 

 

 

Solution:  

• As shown under Common Jumper Settings (page 17), set Channel A to “Logic levels” and 

Channel B to “NPN open collector.” 

• Use Channel A to sense a positive voltage applied to relay coil. Wire Channel B across relay 

contacts. Upon contact closure, Channel B pull-up voltage will drop from 5V to 0V.  

• Under Input+Display tab, set Mode to Stopwatch, Function to “A to B”, and Gate time to 0 

sec. Set Display Type to “Norml 999999”. Native counts will be microseconds. 

• Under Scaling tab, set decimal point to 3 places. Set Trigger Slope A to Positive and Trigger 

Slope B to Negative. If “Scale, Offset” is selected as scaling method, set Scale to +1.00000 

and Multiplier 1 to read in units of 0.001 msec (or native microseconds). If “Coordinates” is 

selected as scaling method, set High In to +010000 and High Read to +010.000. Or select a 

similar pair of numbers which reflect a slope of 1. Ignore Item 2, “Grand Total Time”. 

• Under Analog Out tab, set Range to “4-20mA Current”, Lo Range Reading to +000.000 and 

Hi Range Reading to +200.000. 
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10.5  PHASE ANGLE (Extended main board). 

• Phase A to B (0-360) measures the phase difference between signals of the same period 

applied to Channels A and B over a span from 0° to 360°. Select this span if no negative 

readings are expected.  

• Phase A to B (+/-180) measures the phase difference between signals of the same period 

applied to Channels A and B over a span from -180° to +180°. Select this span if negative 

readings are expected. If you experience an anomaly at 0°, set the A trigger slope to positive 

and the B trigger slope to negative. This will create a 180° offset, which you can correct 

under scaling. 

Example of phase angle measurement with 0.01º resolution 

Application: Measure phase difference to 0.01º between two AC signals centered around 0º. 

 

 

Solution:  

• Jumper the signal conditioner for maximum sensitivity to catch zero voltage crossings and 

minimize effects of amplitude jitter. Apply one AC signal to Channel A and one to Channel B.  

• Under Input+Display tab, select Extended (an extended main board is required for phase). 

Set Mode to Phase, Function to “A to B (+−180)”, and Gate time 1 sec (if one transmittal 

per second is desired). Native units will be degrees.  

• Under Scaling tab, set decimal point to 2 places. Make both trigger slopes the same. If 

“Scale, Offset” is selected as scaling method, set Scale to +1.00000 and Multiplier to 100 to 

change units to hundredths of degrees. If Coordinates is selected as scaling method, enter 

+1.00000 for High In and +0001.00 for High Read, or to a similar pair of numbers for the 

same slope. 
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10.6  POWER FACTOR (Extended main board). 

Power factor of an AC power system is the ratio of real power in watts (W) divided by apparent 

power in volt-amperes (VA). For sinusoidal signals, power factor is calculated from phase angle 

θ as cos(θ). Power factor readings can range from 1.000 to 0.000 with three decimal places 

and an accuracy of 0.1% for sinusoidal signals at 50/60 Hz. While power factor is always 

positive, a minus sign is artificially assigned for negative phase angles, and power factor is set 

to 0 for phase angles greater than 90°. 

Example of power factor measurement to 0.001 resolution 

Application: Measure power factor with 0.001 resolution for two sinusoidal AC signals 

centered around 0º. 

 

 

Solution:  

• As for phase angle, jumper signal conditioner for maximum sensitivity to catch zero voltage 

crossings and minimize effects of amplitude jitter. Apply one AC signal to Channel A and 

one to Channel B.  

• Under Input+Display tab, select Extended (an extended main board is required). Set Mode 

to Phase, Function to “A to B (+–180)”, and Gate time 0.25 sec (if four transmittals per 

second are desired).  

• Under Scaling tab, set decimal point to 3 places. Make both trigger slopes the same. Set 

Custom Curve to “Power Factor”. A Multiplier is not needed with power factor. 
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10.7  DUTY CYCLE (Extended main board) 

Duty Cycle (A to B)/A measures On or Off period as a percentage of total period over a Gate 

Time which is selectable up to 199.99 s. The same signal is applied to Channels A and B. Time 

is measured between positive and negative edges of the signal, with averaging over multiple 

integral periods over the selected Gate Time. Native units are percent. 

Example of duty cycle measurement with 0.01% resolution 

Application: Measure “on” period of periodic laser pulses as % of total period with 0.01% 

resolution over a time interval of 10 sec. Output 0-100% to a 0-10V analog recorder. 

 

 

 

Solution:  

• Under Input+Display, select Extended (an extended transmitter is required for duty cycle). 

Set Mode to “Duty Cycle”. Function will automatically be shown as “(A to B)/A”. Set Gate 

Time to 010.00 Secs.  

• Under Scaling tab, set decimal point to 2 places. Set Trigger Slopes as needed. If “Scale, 

Offset” is selected as scaling method, set Scale to +1.00000 and Multiplier to 100. This will 

change units from 1% to 0.01%. Decimal Point selection does not affect counts. If Coor-

dinates is selected as scaling method, set High In to +0100.00 hundredths of a percent and 

the desired High Read to +0100.00.  
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12.  PROCESS RECEIVER SIGNAL CONDITIONER BOARD 

 

The process receiver signal conditioner board converts 0-1 mA, 4-20 mA or 0-10 V analog 

process signals to a frequency signal, which is then processed mathematically by the counter 

main board to produce an internal reading of rate, total (time x rate), or 1/rate (time based on 

rate). Square root extraction is selectable in software. For example, with this capability, the trans-

mitter can output a serial signal or a 4-20 mA process signal which tracks flow rate or totalized 

flow (volume) from a differential pressure flow transducer. The board needs to be configured via 

jumpers for the input signal type. It is recognized by Instrument Setup software, which will bring 

up the applicable menu items for the V-F Converter input option. 

JUMPER SETTINGS 

 

 

Input Range Jumper Position A1 

0-10V 

0-1 mA 

4-20 mA 

None 

a 

b 

 

 

 

OPERATING MODES 

• A Only (Rate A, Basic counter) accepts 0-1 mA, 4-20 mA or 0-10 V analog process signals 

to calculate an internal rate reading, which is then converted to rate. Scaling can be done by 

entering Scale and Offset, or using the Coordinates of 2 Points method. Measurements are 

averaged over a Gate Time, which is programmable from 10 ms to 199.99 sec. Selecting a 

long Gate Time provides a slower display update rate but superior noise filtering. Moving 

average filtering is selectable for noise reduction. Square root extraction is selectable for use 

with differential pressure flow transducers. Custom curve linearization is available with the 

Extended main board. 

• A, A Total (Rate A, Total A, Basic Counter) allows rate to be determined as Item #1 and total 

as Item #2. Rate can be scaled using Scale and Offset, or the Coordinates of 2 Points 

method. Total can only be scaled using Scale and Offset. Total is calculated by adding rate pr 

second every second. If square root extraction or custom curve linearization (available with 

Extended main board) is selected, the rate used is after square root extraction or linear-

ization. 

• 1/(A Rate) (Extended main board) determines the inverse of rate. For example, this can be 

the time it takes an item to traverse an oven at a measured rate. Like Rate, 1/Rate can be 

scaled using Scale and Offset, or using the Coordinates of 2 Points method. Square Root 

extraction can be selected for rate. 1/Rate is not available with custom curve linearization. 
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Example of rate and volume from a 4-20 mA flow meter 

Application: Transmit flow rate in GPM to three decimals and totalized volume in gallons to two 

places from a 4-20 mA flow meter calibrated so that 4 mA = 0 GPM and 20 mA = 18.756 GPM. 

Do not totalize reported flow rates below 0.050 GPM, as these are deemed to be noise.  

 

 

Solution:  

• Under Input+Display tab, set Signal Input Mode to “VF 4-20 mA”, Function to “A, A Total”, 

Cutoff Value to 00.050, Cutoff Enable to Enabled, and Power-On Total to “Restore Total” (to 

retain total in event of a power failure).  

• Under Scaling tab for “VF 4-20 mA A Rate”, set Decimal Point to three places. If “Scale, 

Offset” scaling method is selected, set Scale 1 to +1.17225 (which is 18.756 GPM / 16.000 

mA), and set Offset 1 to -4.689 GPM (so that 4 mA will read 0 GPM). If Coordinates is 

selected as scaling method, simply enter Low In, Low Read, High In, High Read as shown.  

• Under Scaling tab for “A Total”, the time integration interval 1 sec. Enter 0.3126 Scale 2 

(which is rate in gallons/sec) and +0000.00 for Offset 2 in gallons if you want the starting 

volume to be 0 gallons since last reset.  
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12.  QUADRATURE SIGNAL CONDITIONER BOARD 

 

 

The quadrature signal conditioner can be used for position (Basic or Extended main board) or 

for position or rate (Extended main board). Two quadrature signals, which are 90º out of phase, 

are applied to Channel A and B inputs. Their phase relationship determines whether the count is 

clockwise (+) or counterclockwise (-). A zero index signal may be applied to a Z Channel as a 

position reference. For more detailed information, please see our Counter Manual, which has a 

16-page section on quadrature and zero indexing. Always connect excitation return to Pin 6 of 

P5 (see page 8). 

JUMPER SETTINGS 

 

Input Type E2 E4 E6 E5 

Single ended, with excitation, no zero index 
Single ended, with excitation, with zero index 
Single ended, with external supply, no zero index 
Single ended, with external supply, with zero index 
Differential, with excitation, no zero index 
Differential, with external supply, no zero index 
Differential, with external supply, with zero index 

a, c 
a, c 
c 
c 
b 
b 
b 

a, c 
a, c 
c 
c 
b 
b 
b 

a, c 
a, c 
a, c 
a, c 
a 

a, c 
b 

a, c 
c 

a, c 
a, c 
b, d 
a, c 

c 

Differential, with excitation, with zero index Selection not available 
  

Input Termination (differential inputs only) E1 E3 E5 

For long cable runs (> 1000 ft, > 300 m) a a a 
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Phase for Up Count E7 

A positive, negative B transition (A leads B) 

A positive, positive B transition (B leads A) 

none 

a 
   

Count-by Options E9 

X1 = positive edge of A input 

X2 = positive & negative edges of A input 

X4 = positive & negative edges of A & B inputs 

none 

a 

b 
  

Zero Index Polarity E8 

Positive 

Negative 

c 

none 
 

Zero Index ANDing E10 E8 

Zero Index (no ANDing) 

Zero Index AND /A 

Zero Index AND /B 

Zero Index AND A 

Zero Index AND B 

Zero Index AND /A AND /B 

Zero Index AND /A AND B 

Zero Index AND A AND /B 

Zero Index AND A AND B 

c 

a 

a 

a 

a 

b 

b 

b 

b 

- 

- 

a 

b 

a, b 

- 

a 

b 

a, b 

OPERATING MODES 

• Quadrature Total (Basic or Extended main board) determines position in engineering units 

by subtracting counterclockwise transitions from clockwise transitions, as determined by the 

signal phase relationship, applying a programmable scale factor to the total, and adding a 

programmable offset to the scaled total. The output update rate is set by a Gate Time, which 

should be set to its minimum of 10 ms. When the scaled total reaches a programmable 

Preset, it is reset to Offset.  

• A zero index function is available on a separate zero index channel to reset the count to the 

expected count when a zero index pulse is detected. For example, if 3000 counts is expected 

after three 1000-count revolutions, but the current count is 2998 when the zero index pulse 

is detected, the count is reset to 3000. Since a wide zero index pulse could cause a count 

discrepancy in the region between transitions, the zero index pulse can be shaped by an AND 

combination with the A or B channels, as set by jumpers. Please see the diagram at the top 

of the previous page.  

• Quadrature Rate (Extended main board) determines rate in engineering units by subtracting 

counterclockwise rate from clockwise rate. Both rates can be scaled using Scale and Offset, 

or the Coordinates of 2 Points method. Rate is measured over a gate time, which is 
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programmable from 10 ms to 199.99 sec. Since one of the two channels may not be 

measuring any pulses over the gate time, a Time Out from 10 ms to 199.99 sec is also 

programmable. The transmitter update rate will never be less than every Time Out. 

  

Example of rate in feet/sec from a 1024 pulse/revolution quadrature encoder 

Application: Transmit rate in feet/sec with 3 decimals using a 1024 pulse/revolution quadrature 

encoder tied to a roller with 1.782 ft circumference. Have 4 updates/sec.  

 

 

Solution:  

• Under Input+Display tab, set Signal Input Mode to Quadrature, Function to Rate, Gate Time 

to 0.22 sec, and Time Out to 1.00 sec. Note that quadrature rate only works with Extended 

version. Under “Pulses per Rev”, press the F1 key for details on zero indexing.    

• Under Scaling tab, apply same scaling to clockwise (CW) and counterclockwise (CCW) 

rates, which are subtracted for net rate. Set decimal points to three places, which requires 

the units to be in one thousands of a foot/sec. If “Scale, Offset” scaling method is selected, 

set Scale to +1.74023 one thousands of a foot per/sec per pulse/sec. If Coordinates scaling 

method is selected, set High In to 1024 pulses/sec and High Read to 1.782 ft/sec. Set 

Trigger Slope B to change count direction. 
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13.  DUAL RELAY OPERATION   

 
Dual AC/DC solid state relays rated 120 mA are standard for alarm or setpoint control and are 

independently set up via the “Relay Alarms” tab of Instrument Setup Software. For online help 

with any data entry field, press the F1 key.  

 

• Setpoint. The number to which the current reading is compared if deviation is set to zero. The 

reading is the count in engineering units that is transmitted digitally and is also used for analog 

output. For example, if the transmitted reading is in gallons/minute, the setpoint will be 

referenced to that reading, not to the raw pulse rate sent from a turbine flow meter. 
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 “Active High” On/Off setpoint control 

with deviation =0 

 “Active Low” On/Off setpoint control  

with deviation = 0 
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• Deviation. A positive number that can be added or subtracted from the setpoint, depending on 

the Deviation Type, to determine when an alarm becomes Active or Inactive.  

• Alarm Source. Depending on the Signal Input Mode and Function selected under the Input+ 

Display tab, the alarm can be assigned to any of up to three Items, for example to Item 1  

(A rate / B rate), Item 2 (A rate), or Item 3 (B rate). 

• Alarm State. If “Active High” is selected, the Active Alarm State is defined as being above the 

setpoint. If “Active Low” is selected, the Active Alarm State is defined as being below the 

setpoint. If “Disabled” is selected, the Alarm State is always inactive. 

• Relay State. A setting with ties the Relay State to the Alarm State. If “Active On” is selected, 

the relay will be closed when the Alarm State is 1. If “Active Off” is selected, the relay will be 

open when the Alarm State is 1. 

• Deviation Type. Three choices are offered: Band Deviation, Split Hysteresis, and Span 

Hysteresis. These define how Setpoint and Deviation are to be combined to set Alarm State. 

 

        Split Hysteresis for heater control      Band Deviation for component testing 

In Band Deviation, the relay opens (or closes) when the reading falls within the deviation 

band, and closes (or opens) when the reading falls outside. Two deviation limits lie symmetric-

ally around the setpoint to create the deviation band. Passbands around a setpoint are often 

used for go-no-go component testing. 

In Split Hysteresis, the relay opens (or closes) when the reading goes above the Setpoint plus 

one Deviation, and closes (or opens) when the reading falls below the Setpoint less one 

Deviation. Two Deviation limits lie symmetrically around the Setpoint to create a deviation 

band. A narrow hysteresis band is often used to minimize relay chatter. A wide band can be 

used for on-off control. 

In Span Hysteresis, operation is as for Split Hysteresis, except that the Setpoint is always on 

the high side, and a single Deviation lies below the Setpoint to create the hysteresis band. 

Span Hysteresis is considered by some to be more intuitive than Split Hysteresis. 
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• Alarm Type. Selections are Non-Latching and Latching. Under Non-Latching, the relay is only 

closed (or open) while the Alarm State is Active. Under Latching, the activated relay remains 

closed (or opens) until reset regardless of the Alarm State. Resetting is normally achieved by 

temporarily grounding one of the transmitter’s control inputs, which has been set to Function 

Reset under the “Input+Display” tab. 

• Alarms 1,2 No. Rdgs to Alarm. Selections are binary steps from 1 to 128. This is the number 

of consecutive alarm readings that must occur to create an Active alarm. Numbers higher than 

2 provide some Alarm filtering so that 1 or 2 noisy readings do not cause an Active Alarm. The 

Alarm becomes Inactive if one of the consecutive readings fails to be an Alarm reading. The 

Alarm readings counter then resets to 0. 
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14.  INPUT SIGNAL FILTERING   

 
The Filter tab provides selections to minimize the effect time jitter and electrical noise which 

can affect trigger points. In most cases, filtering is only available for Item 1 and is grayed out 

for totalizing and stopwatch functions.  

 

• Time Constant provides a moving average filter with the following eight equivalent RC time 

constants: no filter, 0.1 sec, 0.2 sec, 0.4 sec, 0.8 sec, 1.6 sec, 3.2 sec, and 6.4 sec. The longer 

time constants provide superior noise filtering at the expense of fast response time. Note that 

filtering can also be accomplished by lengthening the Gate time under the Input+Display tab. 

• Type allows selection of Adaptive or Conventional filtering. With Adaptive, the time constant is 

changed dynamically so that the transmitter can respond rapidly to actual changes in signal 

while filtering out random noise. The moving average filter is reset to the latest reading when 

the accumulated difference between individual readings and the filtered reading exceeds a 

Threshold. The accumulated difference is also reset to zero when the latest reading has a 

different polarity than the filtered reading. With Conventional filtering, the adaptive feature is 

disabled and the Time Constant does not change. 

• Threshold allows selection of Low Adaptive or High Adaptive for the Adaptive filter selection. 

Normally select Low. Select High if the signal has large spurious transients which should not 

be considered as an actual change in signal. 

• Peak/Valley Filter allows the peak (maximum) or valley (minimum) functions to be based on 

Unfiltered or Filtered readings. Normally select Unfiltered. Select Filtered if you expect spurious 

readings which you do not wish to capture. 
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15.  TRANSMITTER CALIBRATION 

 
All ranges of our transmitters have been digitally calibrated at the factory prior to shipment 

using computers and calibration equipment certified to NIST standards. If recalibration is 

required, your transmitter may be returned to the factory or to an authorized distributor. 

The counter main board contains an EEPROM, which stores calibration constants for the quartz 

crystal oscillator and the analog output. The V-to-F converter signal conditioner board stores its 

own stores its own voltage-to-frequency calibration constants EEPROM. The dual channel pulse 

input signal conditioner and quadrature signal conditioner boards do not require calibration. As 

a result, transmitter signal conditioner boards can be interchanged without recalibration.  

 

Calibration of the quartz crystal is easily accomplished using Instrument Setup software. First 

set jumpers for “Logic levels” (top of page 20) to remove filtering. Select Calibration from the 

Main Menu. Apply a frequency reference signal, and enter the known frequency in Hz. 

Calibration of the V-to-F signal conditioner requires use of voltage reference signals and the 

calibration program vfcal3.exe, which is available for free download.  
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16.  CUSTOM CURVE LINEARIZATION 

 
Curve.exe is a DOS-based, executable PC program used to set up an Extended transmitter so 

that the analog output and internal digital readings have a user-defined, non-linear relationship 

with the input signal. The calculated linearizing parameters are downloaded into non-volatile 

memory of the transmitter. The curve-fitting algorithm uses quadratic segments of varying 

length and curvature, and includes diagnostics to estimate curve fitting errors. The program is 

self-prompting, avoiding the need for detailed printed instructions. This manual section is only 

intended as an introduction.  

GETTING STARTED 

Download curve.exe from the distribution CD into the same directory that will contain your 

data files, such as c:\curves. Connect your transmitter to the PC and double-click on curve.exe, 

which is an executable file. Follow the steps on the computer screens, which will prompt you 

and provide extensive help information. Pressing R (Enter) returns to the main menu. You will 

be given the choice of four data entry modes, all of which are explained in detail.  

1)  Text file entry mode,  

2)  2-coordinate keyboard entry mode,  

3)  2-coordinate file entry mode, and  

4)  Equation entry mode. 
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17.  MODBUS PROTOCOL TRANSMITTER COMMUNICATIONS  

1.0  GENERAL 

The Modbus capability conforms to the Modbus over Serial Line Specification & Implemen-

tation guide, V1.0.  Both the Modbus RTU and Modbus ASCII protocols are implemented. This 

5-page manual section presents key programmable Modbus features. Our detailed Modbus 

manual can be downloaded from http://www.laurels.com/downloadfiles/modbus.pdf 

Modbus RTU 

Baud Rate ........... 300, 600, 1200, 2400, 4800, 9600 or 19200 

Data Format ....... 1 start bit, 8 data bits, 1 parity bit, 1 stop bit (11 bits total) 

Parity .................. None, Odd, Even (if None, then 2 Stop bits for 11 total) 

Address .............. 0 for broadcast, 1-247 for individual meters 

Modbus ASCII 

Baud Rate ........... 300, 600, 1200, 2400, 4800, 9600 or 19200 

Data Format ....... 1 Start bit, 7 Data bits, 1 Parity bit, 1 Stop bit (10 bits total) 

Parity .................. None, Odd, Even (if None, then 2 Stop bits for 10 total) 

Address .............. 0 for broadcast, 1-247 for individual meters 

2.0  FRAMING 

Modbus RTU: Message frames are separated by a silent interval of at least 3.5 character times. 

If a silent interval of more than 1.5 character times occurs between two characters of the 

message frame, the message frame is considered incomplete and is discarded. Frame Check = 

16 bit CRC of the complete message excluding CRC characters. 

Modbus ASCII: The message begins immediately following a colon (:) and ends just before a 

Carriage Return/ Line Feed (CRLF). All message characters are hexadecimal 0-9, A-F (ASCII 

coded). The system allowable time interval between characters may be set to 1, 3, 5 or 10 

seconds. Frame Check = 1 byte (2 hexadecimal characters) LRC of the message excluding the 

initial colon (:) and trailing LRC and CRLF characters. 

3.0  COMMUNICATIONS SETUP 

Parameters selectable via downloaded Instrument Setup software: 

Serial Protocol ............................... Custom ASCII, Modbus RTU, Modbus ASCII 

Modbus ASCII Gap Timeout ........... 1 sec, 3 sec, 5 sec, 10 sec 

Baud Rate ....................................... 300, 600, 1200, 2400, 4800, 9600, 19200 

Parity  ............................................. No parity, odd parity, even parity 

Device Address  ............................. 0 to 247 

http://www.laurels.com/downloadfiles/modbus.pdf
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4.0  SUPPORTED FUNCTION CODES 

FC03: Read Holding Registers 

Reads internal registers containing setup parameters (Scale, Offset, Setpoints, etc.) 

FC10: Write Multiple Registers (FC10 = 16 dec) 

Writes internal registers containing setup parameters (Scale, Offset, Setpoints, etc.) 

FC04: Read Input Registers 

Reads measurement values and alarm status. Returns values in 2's Complement Binary Hex 

format without a decimal point. The displayed system decimal point can be read with FC03 at 

address 0057.  Use only odd Register Addresses and an even number of Registers. 

Register 

Address TM Transmitter Response 

-------         ----------------------------------------------- 

00 01    Returns Hi word of Alarm status 

00 02    Returns Lo word of Alarm status 

00 03    Returns Hi word of Measurement value 

00 04    Returns Lo word of Measurement value  

00 05    Returns Hi word of Peak value 

00 06    Returns Lo word of Peak value   

00 07    Returns Hi word of Valley value 

00 08    Returns Lo word of Valley value  

FC05: Write Single Coil 

Action command to meter 

Output  Output  

Address   Value    Action Command 

-------   --------   ---------------------------------------- 

00 01    FF 00  Transmitter Reset  (No Response) 

00 02    FF 00  Function Reset (Peak, Valley) 

00 03    FF 00    Latched Alarm Reset 

00 04    FF 00    Peak Reset 

00 05    FF 00    Valley Reset 

00 0C    FF 00    Tare Command (Weight Transmitter) (00 00 resets Tare) 

FC08: Diagnostics 

Checks communications between the Master and Slave, and returns the count in the Modbus 

Slave counters (which are reset when the meter is reset). 
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Hex Sub 

Function 

Code 

Data 

Send 

Response 

Data 
Description 

00 00 Any Same 

as sent 

Returns Query Data (N x 2 bytes). Echo Request.  

00 01 

FF 00 

00 00 

FF 00 

00 00 

Restarts Communications. If in the Listen-Only mode, no 

response occurs. Takes Slave out of the Listen-Only mode 

and one of the following: 

Clears communications event counters. 

Does not clear communications event counters. 

00 04 00 00 None Forces Listen-Only.  All addressed and broadcast 

Messages are monitored and counters are incremented, 

but no action is taken or response sent. Only Sub-

Function 00 01 causes removal of this Listen-Only state. 

00 0A 00 00 00 00 Clears all Modbus slave counters. 

00 0B 00 00 Total 

Message 

Count 

Returns total number of messages detected on the bus, 

including those not addressed to this Slave. Excludes bad 

LRC/CRC, parity error or length < 3. 

00 0C 00 00 Checksum 

Error 

Count 

Returns total number of messages with bad LRC/ CRC, 

parity or length < 3 errors detected on the bus including 

those not addressed to the Slave. 

00 0D 00 00 Exception 

Error 

Count 

Returns total number of Exception responses returned by 

the Addressed Slave or that would have been returned if 

not a broadcast message or if the Slave was not in a 

Listen-Only mode. 

00 0E 00 00 Slave 

Message 

Count 

Returns total number of messages, either broadcast or 

addressed to the Slave.  Excludes bad LRC/CRC, parity or 

length < 3 errors. 

00 0F 00 00 No 

Response 

Count 

Returns total number of messages, either broadcast or 

addressed to the Slave, for which Slave has returned No 

Response, neither a normal response nor an exception 

response. Excludes bad LRC/CRC, parity or length < 3 

errors. 

00 11 00 00 Slave 

Busy 

Returns total number of Exception Code 6 (Slave Busy) 

responses. 
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5.0  SUPPORTED EXCEPTION RESPONSE CODES 

Code Name      Error Description 

----  --------------------  ------------------------------------------------------ 

01    Illegal Function       Illegal Function Code for this Slave. Only hex Function 

   Codes 03, 04, 05, 08, 10 (dec 16) are allowed. 

02    Illegal Data Address   Illegal Register Address for this Slave. 

03 Illegal Data Value     Illegal data value or data length for the Modbus protocol. 

04    Slave Device Failure   Slave device failure (eg. Transmitter set for external gate). 

6.0  MESSAGE FORMATTING 

MA = Meter Address          DD = Data (Hex)        CL = CRC Lo Byte 

FC  = Function Code          WW = Data (On/Off)     CH = CRC Hi Byte 

RA = Register Address       SF = Sub-Function      CR = Carriage Return 

NR = Number of Registers    EC = Error Code        LF = Line Feed 

NB = Number of bytes        LRC = ASCII Checksum 

Modbus RTU Format 

FC Action 
> 3.5 

Char 

Byte Number 

1 2 3 4 5 6 7 8 9 10 11 

03 

03 

Request 

Response 

NoTx 

NoTx 

MA 

MA 

FC 

FC 

RA 

NB 

RA 

DD* 

NR 

DD* 

NR 

CL 

CL 

CH 

CH    

04 

04 

Request 

Response 

NoTx 

NoTx 

MA 

MA 

FC 

FC 

RA 

NB 

RA 

DD* 

NR 

DD* 

NR 

CL 

CL 

CH 

CH    

05 

05 

Request 

Response 

NoTx 

NoTx 

MA 

MA 

FC 

FC 

RA 

RA 

RA 

RA 

WW 

WW 

WW 

WW 

CL 

CL 

CH 

CH 

   

08 

08 

Request 

Response 

NoTx 

NoTx 

MA 

MA 

FC 

FC 

SF 

SF 

SF 

SF 

WW 

DD 

WW 

DD 

CL 

CL 

CH 

CH 

   

10 

10 

Request 

Response 

NoTx 

NoTx 

MA 

MA 

FC 

FC 

RA 

RA 

RA 

RA 

NR 

NR 

NR 

NR 

NB 

CL 

DD* 

CH 

DD* CL CH 

Exception 

Response 

NoTx MA FC 

+80 

EC CL CH       

DD* = (DD DD) times NR (Number of Registers) 
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Modbus ASCII Format 

FC Action 
Byte Number 

1 2 3 4 5 6 7 8 9 10 11 12 13 

03 

03 

Request 

Response 

: 

: 

MA 

MA 

FC 

FC 

RA 

NB 

RA 

DD* 

NR 

DD* 

NR 

LRC 

LRC 

CR 

CR 

LF 

LF    

04 

04 

Request 

Response 

: 

: 

MA 

MA 

FC 

FC 

RA 

NB 

RA 

DD* 

NR 

DD* 

NR 

LRC 

LRC 

CR 

CR 

LF 

LF    

05 

05 

Request 

Response 

: 

: 

MA 

MA 

FC 

FC 

RA 

RA 

RA 

RA 

WW 

WW 

WW 

WW 

LRC 

LRC 

CR 

CR 

LF 

LF 

   

08 

08 

Request 

Response 

: 

: 

MA 

MA 

FC 

FC 

SF 

SF 

SF 

SF 

WW 

DD 

WW 

DD 

LRC 

LRC 

CR 

CR 

LF 

LF 

   

10 

10 

Request 

Response 

: 

: 

MA 

MA 

FC 

FC 

RA 

RA 

RA 

RA 

NR 

NR 

NR 

NR 

NB 

LRC 

DD* 

CR 

DD* 

LF 

LRC CR LF 

Exception 

Response 

: MA FC 

+80 

EC LRC CR LF       

DD* = (DD DD) times NR (Number of Registers) 

7.0  MESSAGE EXAMPLES 

   All examples are for Transmitter Address = 01 and No Parity. 

Ser_4 -> 

Addr -> 

Action 

Modbus RTU 

010 

001 

Modbus ASCII 

020 

001 

Restart Com-

munications 

Request 

Response* 

010800010000B1CB 

010800010000B1CB 

:010800010000F6crlf 

:010800010000F6crlf 

Meter Reset Request 

Response 

01050001FF00DDFA 

None 

:01050001FF00FAcrlf 

None 

Digital Reading 

** *** 

Request 

Response 

01040003000281CB 

010404000009D67C4A 

:010400030002F6crlf 

:010404000009D618crlf 

Write Setpoint 

1 = +37.00*** 

Request 

Response 

0110000100020400000E743624 

01030400000E74FE74 

:0110000100020400000E7466crlf 

:011000010002ECcrlf 

Read Setpoint 

1 = +37.00*** 

Request 

Response 

01030001000295CB 

01030400000E74FE74 

:010300010002F9crlf 

:01030400000E7476crlf 

*  Suggested as first message after power-up. If transmitter is in Listen-Only mode, no response 

    is returned.  ** Example while reading +25.18  ***  Decimal point is ignored. 

8.0   INTERNAL REGISTERS:  Please refer to the full Modbus Protocol Communications Manual, 

which is downloadable from our website.  
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18.  CUSTOM ASCII PROTOCOL TRANSMITTER COMMUNICATIONS  

 
1.0    SERIAL COMMUNICATION FORMAT 
 

Mode ................ Full Duplex (Separate transmit and receive lines) and Half Duplex (RS485 only) 

Baud Rate ......... 300, 600, 1200, 2400, 4800, 9600, 19200 selectable with Instrument Setup 

software. 

Parity ................ None 

Word length ...... 8 data bits 

Stop bit  ............ 1 

The Custom ASCII protocol is simpler than the Modbus protocol. This 5-page manual section 

provides some of its key programmable features. Our detailed Serial Communications manual 

can be downloaded from http://www.laurels.com/downloadfiles/serialcom2.pdf 

2.0    MEASUREMENT DATA FORMAT 
 

The basic measurement data format consists of 8 ASCII characters for analog input “DPM” 

transmitters, such as +999.99<CR>, where <CR> is the carriage return character. The first 

character is always a plus or minus sign. A decimal point is always furnished, even when it 

follows the last digit. 

Adding a Line Feed Character to the Basic Format: Printers and other devices that receive the 

data may require a line feed character <LF> following the <CR>. The line feed character <LF> 

may be selected using Instrument Setup software. 

Adding a Coded Data Character to the Basic Format: A coded character from A to H may be 

added to the data string according to the table below to indicate the alarm and overload status 

of the device. If used, this character precedes the <CR>, so that it is the last printable character 

in the string. With the optional <LF> and coded character selected, the data string will consist 

of 10 characters for analog input “DPM” transmitters, such as +999.99A<CR><LF>. 

Alarm Status No Overload Overload 

**Neither Alarm 

set 

Alarm 1 set only 

Alarm 2 set only 

Both Alarms set 

A 

B 

C 

D 

E 

F 

G 

H 

 

For example, a coded character “G” indicates that Alarm 2 only is set and that the transmitter is 

in the overload condition. This information is useful when data is supplied to a computer for 

http://www.laurels.com/downloadfiles/serialcom2.pdf
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listing and analysis, or when data is supplied to a Remote Display in a Master-Slave confi-

guration. 

Values are transmitted in a continuous string with no intervening spaces. If the 5th digit in is 

set to 1 using Instrument Setup software, the termination characters of <CR> and optional 

<LF> appear after each value. If the 5th digit is et to 0, the termination characters appear only 

once at the end of the string. In either case, if included, the coded character appears at the end 

of the last value only. 

3.0    NETWORK CONFIGURATIONS 

Using the Custom ASCII protocol, TM Series transmitters can operate in a point-to-point mode 

using RS232 or RS485, or in a multi-point mode using RS485. 

The point-to-point mode is a direct connection between a computer (or other digital device) 

and the transmitter. Any device address can be selected; however, it is suggested that address 

1 be selected as a standard for the point-to-point mode. 

The multi-point mode is a connection from a host computer to a multiplicity of transmitters 

bused together with their inputs and outputs connected in parallel. For long cable runs, the last 

device should have a termination resistor installed. It is necessary to set up each device  on the 

bus with a different address from 1 to 31. To command a particular device, its address is used 

in conjunction with the command, and only that device responds. The outputs of all of the 

devices on the bus are set to a high impedance state, except the device being addressed. The 

device addresses range from 1 to 31, with 0 being a special address to which a meter responds 

only internally (e.g. Reset), but does not transmit any response on the output lines. All devices 

may be commanded simultaneously with a 0 address, and there will not be any output 

response contention.  Addressing of transmitters can be set with Instrument Setup software.    

4.0   COMMAND MODE OVERVIEW  

Using the Custom ASCII protocol, TM Series transmitters operate in the Command Mode only. 

In this mode, the device does not send data automatically, but responds to commands received 

from a host computer. These commands can be: 

• To transmit the latest or peak measurement 

• To reset the meter completely or just the peak value and/or latched alarms 

• To display a value sent from the computer 

• To transmit present setup parameters 

• To receive new setup parameters, 

• To monitor or alter data in selected memory locations of the meter. 

5.0   COMMAND MODE FORMAT 

CHAR 1 - Command Identifier 
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All commands begin with “*” followed by the meter address, then a command letter 
followed by a sub-command number or letter. Additional characters may be append-
ed. All commands terminate with <CR> (<LF> ignored). 

Char # Character Description 

1 

2 

3 

4 

* 

0-V 

A-Z 

0-U 

Command Identifier. Recognition Character. 

Device Address. 0 addresses all devices, 1-V specific devices. 

Command Function 

Sub-command. Number of Bytes of RAM or Words (2 Bytes) of 

non-volatile memory data being transferred. 

CHAR 2 - Address Codes 

A Serial Communications Address Code from 1 to V follows the “*” to indicate the device 

address number from 1 to 31. 

Device # 
Address 

Code 
 Device # 

Address 

Code 

 
Device # 

Address 

Code 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

1 

2 

3 

4 

5 

6 

7 

8 

9 

A 

B 

 12 

13 

14 

15 

16 

17 

18 

19 

20 

21 

22 

C 

D 

E 

F  

G 

H 

I 

J 

K 

L 

M 

 23 

24 

25 

26 

27 

28 

29 

30 

31 

N 

O 

P 

Q 

R 

S 

T 

U 

V 

CHARS 3 & 4 - Commands and Subcommands 

The examples below use a default address of 1 following the “*“. Substitute the desired 

address from the above table of Serial Comm Address Codes. All command sequences shown 

must terminate with <CR>, followed by an optional <LF>. 

Request DPM Values 

Get reading**    *1B1 

Peak reading    *1B2 

Valley reading   *1B3 

**  The meter transmits the value or values selected with Instrument Setup software. 
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Reset Functions, DPM Transmitter 

Cold reset     *1C0   Reads NVMEM into RAM locations after RAM is zeroed. 

Latched alarms reset  *1C2 

Peak value reset   *1C3 

Remote display reset  *1C4 

Valley reset   *1C9 

Tare function   *1CA 

Tare reset    *1CB 

6.0    READING AND WRITING TO RAM AND NONVOLATILE MEMORY 

CHAR 1, 2:   The Recognition character and Meter Address Code are the same as shown in 

previous table. 

CHAR 3:   Command character: 

  G  Read bytes from RAM Memory 

  F  Write bytes to RAM Memory (DPM and Scale meter only) 

  R  Read bytes from Upper RAM Memory 

  Q  Write bytes to Upper RAM Memory 

  X  Read words from Non-Volatile Memory 

  W  Write words to Non-Volatile Memory 

CHAR 4:  Command character. Sub-command. Number of Bytes of RAM or Words (2 Bytes) of 

non-volatile memory data being transferred. 

Code # Number  Code # Number  Code # Number 

1 

2 

3 

4 

5 

6 

7 

8 

9 

A  

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

 B  

C 

D 

E 

F  

G 

H 

I 

J 

K 

11 

12 

13 

14 

15 

16 

17 

18 

19 

20 

 L 

M  

N 

O 

P 

Q 

R 

S 

T 

U 

21 

22 

23 

24 

25 

26 

27 

28 

29 

30 

CHAR 5, 6:  See tables for the RAM MEMORY ADDRESSES and NONVOLATILE MEMORY 

ADDRESSES with their respective data definitions. 
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General, Reading and Writing Ram Memory Data 

RAM memory data is read and written as a continuous string of bytes consisting of 2 hex 

characters (0-9,A-F) per byte. Included in the command are the total number of bytes to be 

transferred and the most significant address in RAM of the continuous string of bytes. The 

format is: 

Read lower RAM data *1Gnaa   

Write lower RAM data *1Fnaa<data> 

Read upper RAM data *1Rnaa   

Write upper RAM data *1Qnaa<data> 

where:  n    is the number of bytes to be read or written. 

aa is the most significant address in RAM of the bytes to be read 

or written. 

<data>  is n bytes of 2 hex characters per byte in order from the most 

to the least significant byte. 

The number of bytes n consists of a single code character representing values from 1 to 30 as 

shown above under CHARACTER 4. The most significant address aa consists of 2 hex charac-

ters as shown below under RAM MEMORY ADDRESSES AND DATA DEFINITIONS. 

General, Reading and Writing Nonvolatile Memory Data 

Nonvolatile data is read and written as a continuous string of words consisting of 2 bytes or 4 

hex characters (0-9,A-F) per word.  Included in the command is the total number of words to 

be transferred and the most significant address in nonvolatile memory of the continuous string 

of words.  The format is: 

Read nonvolatile memory data    *1Xnaa   (followed by Meter reset) 

Write non-volatile memory data   *1Wnaa <data>  (followed by Meter reset) 

where:  n   is the number of words to be read or written. 

aa  is the most significant address in nonvolatile memory of the words to be 

read or written. 

<data>  is n words of 2 bytes or 4 hex characters per word in order from the most to 

the  least significant address. 

The coded number of words n consists of a single character representing values from 1 to 30 

as shown under CHARACTER 4. The most significant address aa consists of 2 hex characters 

as shown under NONVOLATILE MEMORY ADDRESSES. 
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19.  SPECIFICATIONS, LTE SERIES PULSE INPUT TRANSMITTERS 

 
Mechanical 

Case dimensions .......................................................................................... 120 x 101 x 22.5 mm 

Case mounting ................................................................................ 35 mm DIN rail per EN 50022 

Electrical connections ............................................................. Detachable screw plug connectors 

Environmental 

Operating temperature ................................................................................................ 0°C to 55°C 

Storage temperature ................................................................................................ -40°C to 85°C 

Relative humidity ........................................................... 95% from 0°C to 40°C, non-condensing 

Power & Electrical 

Power to Transmitter .......................... 85-264 Vac or 90-300 Vdc (DC range is not ETL certified) 

 .................................................................... 12-32 Vac or 10-48 Vdc (low voltage power option) 

Power Isolation ....... 250 Vrms between power, signal input, analog output, relays, and serial I/O 

Transmitter Setup 

Selection of signal ranges & temperature sensors .............. Jumpers on signal conditioner board 

Selection of excitation output & analog output ........................................ Jumpers on main board 

Programming ................................... Via PC using Instrument Setup software and Ethernet cable 

Analog to Digital Conversion) 

Conversion rate ..................................................... 60/sec at 60 Hz power, 50/sec at 50 Hz power 

Input resolution .......................................................................................... 16 bits (65,536 steps) 

Analog Output (standard) 

Output Levels ................................................................. 4-20 mA, 0-20 mA, 0-10V, -10V to +10V 

Compliance at 20 mA .................................................................................. 10V (0-500 ohm load) 

Compliance at 10V ......................................................................... 2 mA (5 kohm minimum load) 

Output Resolution ....................................................................................... 16 bits (65,536 steps) 

Output Accuracy ...................................................................................................... ±0.02% of FS 

Output Update Rate, Max ............................. 30/sec. Limited by programmable gate time for rate 

Output Filtering ......................................................................................... Digitally programmable 

Ethernet I/O (standard) 

Serial protocols ..................................................Modbus (TCP, RTU or ASCII) and Custom ASCII 

Serial connector .................................................................................................................... RJ45 

Data rates .......................................................................................................... 300 to 9600 baud 

Transducer Excitation Output (standard) 

Output Isolation ....................................................................................... 50 Vdc to meter ground 

Selectable levels ................. 5 Vdc ± 5%, 100 mA;  10 Vdc ± 5%, 120 mA;  24 Vdc ± 5%, 50 mA  
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Relay Output (standard) 

Relay type ................................................... Two solid state relays, SPST, normally open, Form A 

Load rating ................................................................................... 130 mA at 140 Vac or 180 Vdc 

DUAL CHANNEL SIGNAL CONDITIONER 

Crystal Accuracy at 25ºC .................................................................................................... ±2 ppm 

Crystal Tempco ................................................................................................... ±1 ppm/degree C 

Long-Term Drift of Crystal ......................................................................................... ±5 ppm/year 

Signal Types .................... AC, NPN, PNP transistor outputs, contact closures, magnetic pickups 

Max Pulse Rate  ........................................................ 1 MHz on Channel A, 250 kHz on Channel B 

Channel Isolation ..................................................Channel A & channel B share common ground 

Low Pass Filter ................................................................................ 250 Hz or 30kHz (selectable)  

Hysteresis ..................................................................................... 15 mV to 2.2 Vp-p (selectable) 

Trigger level .................................................................................... ±15 mV to ±1.7 V (selectable) 

Debounce Circuitry ...................................................................................0, 3, 50 ms (selectable) 

V-TO-F PROCESS RECEIVER & TOTALIZER SIGNAL CONDITIONER 

Signal Levels ...................................................................... 0-1 mA, 4-20 mA, 0-10 V (selectable) 
Input Resistance ............................ 50Ω for 4-20 mA, 1.00 k Ω for 0-1 mA, 1.01 MΩ for 0-10V 

Accuracy at 25ºC ............................................................................................................... ±0.01% 

Span Tempco ........................................................................................... ±0.003% of reading /°C 

Zero Tempco .......................................................................................... ±0.003% of full scale /°C 

QUADRATURE SIGNAL CONDITIONER 

Signal Type ....................................................................... Differential or single-ended quadrature 

Transitions Monitored................................................................................................. x1, x2 or x4 

Max Pulse Rate ........................................................ 250 kHz at x1, 125 kHz at x2, 62.5 kHz at x4 

Differential High Threshold Voltage ................................................................................ +200 mV 

Differential Low Threshold Voltage .................................................................................. -200 mV 

Differential Limits ..................................................................................................... -11V to +14V 

Common Mode Voltage for ±200 mV sensitivity..................................................................... ±7V 

Single-ended High Voltage......................................................................................... 2.5V to 5.5V 

Single-ended Low Voltage ............................................................................................ -1V to +1V 

Input resistance, Typ. ..................................................................................................... 17 kOhm 

Conversion Technique for Rate ......................................................................................... 1/period 

Conversion Time for Rate ........................... Programmed gate time + 30 ms + 0-2 signal periods 

Time Before Zero Output for Rate ...................................................... 0 to 199.99 sec (selectable) 

Zero Wait Time for Rate ..................................................................... 0 to 199.99 sec (selectable) 

Output Update for Rate ........................................................................... Same as conversion rate 

Output Update for Total ....................................................................................................... 30 ms 

Time Base Accuracy for Rate ........................................................................ Calibrated to ±2 ppm 

 



- 61 - 

20. WARRANTY

Laurel Electronics Inc. warrants its products against defects in materials or workmanship for a 

period of one year from the date of purchase.   

In the event of a defect during the warranty period, the defective unit may be returned to the 

seller, which may be Laurel or a Laurel distributor. The seller may then repair or replace the 

defective unit at its option. In the event of such a return, freight charges from the buyer shall be 

paid by the buyer, and freight charges from the seller shall be paid by the seller. 

LIMITATION OF WARRANTY 

The foregoing warranty shall not apply to defects resulting from: 

1. Improper installation or miswiring.

2. Improper or inadequate maintenance.

3. Unauthorized modification or misuse.

4. Operation outside the environmental specifications.

5. Mishandling or abuse.

The warranty set forth above is exclusive and no other warranty, whether written or oral, is 

expressed or implied. Laurel specifically disclaims implied warranties of merchantability and 

fitness for a particular purpose. 

Any electronic product may fail or malfunction over time. To minimize risks associated with 

reliance on Laurel products, users are expected to provide adequate system-level design and 

operating safeguards. Laurel’s products are intended for general purpose industrial or 

laboratory use. They are not intended nor certified for use in life-critical medical, nuclear, or 

aerospace applications, or for use in hazardous locations. 

EXCLUSIVE REMEDIES 

The remedies provided herein are Buyer’s sole and exclusive remedies. In no event shall Laurel 

be liable for direct, indirect, incidental or consequential damages (including loss of profits) 

whether based on contract, tort, or any other legal theory. 

Copyright 2009-2023, Laurel Electronics, LLC    16 May 2023 




